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PHOTO MECHANIC 

PHOTO MECHANIC FROM CAMERABITS  

http://www.camerabits.com/  

Latest version is 4.6.x 

Available for both Mac and Windows. 

 

PHOTO MECHANIC OVERVIEW 

Photo Mechanic is an image browser designed to take advantage of advanced features in  the more recent 

Microsoft Windows and Apple Mac OS X operating systems. Photo Mechanic requires Windows Vista,Windows 

XP, Mac OS X 10.4.11 or later. Its software footprint, however, is light enough that it can run adequately on many 

of the smaller netbooks (the new ultra-small laptops). 

The primary users of Photo Mechanic have been newspaper and sports photographers, although others who 

need a very fast way to browse and annotate images have jumped on board, as well. Photo Mechanic fits into the 

class of applications referred to as browser or annotation software. Have no doubts: This application is a first-

class image browser that can rapidly add metadata to images.  

http://www.camerabits.com/
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Photo Mechanic displays JPEG, PNG, TIFF, PSD, DNG, and a wide variety of Raw files, as well as various movie 

formats (AVI, MOV, MPEG4, etc.). GIF and TGA still formats can be viewed with QuickTime software also 

installed. It can embed IPTC and XMP metadata in JPEG, TIFF, PSD, DNG and a wide variety of Raw files. 

SET METADATA PREFERENCES BEFORE USE 

It's important to note how Photo Mechanic adds metadata to such files depends on the options set in its 

application preferences. Photo Mechanic really stresses the "mechanic" part of its name. It is very flexible in how 

it reads and writes metadata values with both the legacy form of IPTC and with XMP. You really need to invest a 

few minutes up front to configure preferences and test the resulting files to ensure metadata values are written in 

a way that will be read correctly further on in your particular workflow. 

If you capture Raw files, and use an Adobe-based workflow – in which you will process the files in Lightroom or 

Adobe Camera Raw – then you will want to set up Photo Mechanic so it only writes metadata to an XMP sidecar 

file for Raw images. 

 

Pictured above is the Mac version of the Photo Mechanic IPTC/XMP preference panel configured for working with Raw files 

that will ne part of an Adobe workflow. This configuration will write both legacy and IPTC and XMP metadata to JPEG, TIFF 

and PSD files, and XMP to DNG files. XMP sidecar files are created or written for any proprietary Raw file formats. 

Color Labels 

If you want the color labels you apply with Photo Mechanic to be viewed in other Applications, such as Adobe 

Bridge or Lightroom, then you need to modify the preferences. These metadata values are actually stored as text 

labels, so it's the name that appears in the field that makes a difference, not the color indicator. 

http://photometadata.org/META-Resources-Glossary-of-Terms#RAW
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If you want your color labels to be visible in other Adobe applications, such as Bridge and Lightroom, be sure that the values 

for each of these are aligned with the other programs you are using. 

 

BASIC FUNCTIONS 

Photo Mechanic works on a model of a photographic contact sheet. After opening Photo Mechanic, you are 

prompted to open a folder of images to work on. You can choose from the navigation menu presented or close 

the dialogue by pressing cancel and use the directory tree along the left-hand side.  

As mentioned above, Photo Mechanic is primarily an image annotator. Once you annotate the images, you can 

move or copy them to their final destination. You can then catalog them with your choice of cataloging software, 

or ingest them into your enterprise Digital Asset Management (DAM) application. Then you will be able to search 

by keyword, caption, location, etc. The Find feature within Photo Mechanic is limited to searching the metadata 

only within the active contact sheet. The Find and Replace feature is more typically used to search and replace 

words or text strings. The Mac version taps into the underlying Spotlight search capability and uses this indexed 

information to perform systemwide searches within the Search and Quick Search features. For more detail, see 

the section below on Locating Photos.  

It is possible to open multiple contact sheets at once, although having many tabs open may affect software 

performance. If you capture Raw+JPEG, then you may notice the filenames in the contact sheet view show the 

name Raw file format with a +jpg added, such as “filename.nef+jpg.” Photo Mechanic lets you to treat both 

images as a single entity, something only a few other imaging applications allow. This saves you from having to 

select the pair of images each time you add metadata. (Note: Photo Mechanic writes metadata to both files using 

the settings you have specified in the IPTC/XMP tab of the Preferences dialog.) 



 

 

PhotoMetaData: Photo Mechanic Tutorial 
 
Photometadata.org was developed by the Stock Artists Alliance in partnership with the Library of Congress 

©2009 Stock Artists Alliance.  http://www.stockartistsalliance.org 

 

4 

 

In a Mac view of a Photo Mechanic Contact Sheet, note the Navigation options on the left-hand side, and the single set of 

thumbnails representing both Raw (NEF) and JPEG versions of the same image capture. Notice the file name extension under 

each thumbnail is “.nef+jpeg.” 

Double-clicking any image thumbnail will open that image in a Preview window where you can see the entire 

frame, zoom in to a 1 : 1 view, compare it to others within the folder and much more. This tutorial focuses on 

entering metadata, so check out other tutorials, or view the Photo Mechanic User Manual for details about these 

other processes. 

ADDING METADATA 

With Photo Mechanic, you view and modify the IPTC information for individual images from the contact sheet. The 

simplest way is to hover your cursor over the first image you want to check or modify.  

http://www.camerabits.com/download/PMGuide.pdf
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Clicking on the "i" button in the lower left of the highlighted image in the contact sheet will open the IPTC Info dialogue where 

you can view or edit an individual image’s metadata. 

Click you see the lowercase letter “i” in a circle in the lower left of the thumbnail and the IPTC Info dialogue will 

open. You can also press the "i" key on your keyboard.  

 

Above is the Mac IPTC Info dialogue, where you can view or edit your photo metadata. To move backward and forward 

through the series of images, use the navigation controls to the right (note location of mouse cursor), or the arrow keys on your 

keyboard. 
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On the right side of the resulting IPTC Info dialogue, you will see several options: 

 <- indicating Go to previous image 

 Save & <- indicating Save the changes and go to the previous 

 Save & -> indicating Save the changes and go to the next image 

 -> indicating Go to next image 

 Copy and Paste buttons that duplicate ALL contents of every field that includes information. 

 

If you simply want to browse the images, just keep pressing the next button [ -> ]. There are keyboard shortcuts 

for most of these buttons. To view the shortcuts, hover your cursor over each button for a moment and a tool tip 

will appear. 

While it’s possible to fill fields with metadata, and choose Copy before clicking on the Save & -> button and Paste 

it into the next image, it is much easier to use Photo Mechanic’s IPTC Stationary Pad for batch annotations. This 

stationary pad is much the same as the metadata templates in other programs, making it easy to enter the same 

metadata for several or many images at the same time. If you use that option, the IPTC Info dialogue provides an 

easy method to fine tune captions or keywords that change from image to image. 

 

STAR RATINGS 

The star ratings within Photo Mechanic are stored in the XMP metadata, so they work well with an Adobe 

workflow if you are using the preferences shown at the beginning of this tutorial. To apply, simply click any 

number of the grayed-out stars in the lower left of an image in the contact sheet, IPTC Info or Preview modes. If 

you prefer, there are shortcut keys for each rating. You’ll find the keyboard shortcut appropriate to your operating 

system under the Image menu, within the Set Rating of Photos submenu. This last method can apply the same 

star rating to any current selection of images, as well as single images. 

 

After rating images, you can easily show or hide those of a specific rating with the filters found in the lower-right 

border of the contact sheet view. Used in conjunction with color labels it's very easy to pinpoint your best images, 

or to pull together a set you need to process into a contact sheet, web gallery or set of images to email. 
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BATCH CAPTIONING WITH THE IPTC STATIONERY PAD 

For multiple files, it is much easier to use the IPTC Stationery Pad – the Photo Mechanic equivalent of a 

metadata template – to apply metadata to all selected images at the same time. This feature is the real 

powerhouse for applying metadata with Photo Mechanic. Since the IPTC Stationery Pad holds the last set of data 

entered, many will find it just as easy to use this method for applying metadata to single images or selections. 

 

The IPTC Stationery pad (Windows version shown above) is a flexible metadata template generator to create, load, save and 

apply metadata to any number of image files at the same time. Note above the pop-up menu is activated for the “City” 

metadata field, showing a pick list of previously saved terms. 

The key difference from the standard IPTC Info dialogue is you can select a group of images in a folder and apply 

the contents of the IPTC Stationery Pad. All field entries are retained from the last use, unless you used the Clear 

button to selectively remove them. Select images with your shift or control/command keys, just as you do with 

most other applications. You can then load a previously saved template, or use the information left from the last 

entry. If you click in a field and start typing, a checkmark will appear in a box next to the field, indicating it will be 

added to the image when you press the Apply Stationery to Selection button.  

If the check box next to the field is empty, then that field in the original image file will not be replaced or 

overwritten. Since metadata is replaced only in those fields where the check box is active, you can load a 

template with more information than you intend to use and simply uncheck the boxes next to the unneeded fields. 
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If you leave a data field blank but do check the box, any previously entered information will be removed from that 

field.  

If you regularly type in certain values, such as Cities or States, you can set up a customized pick list for any fields 

that appear in the IPTC Stationery Pad or IPTC Info dialogues. You can create or access these pop-up pick lists 

by clicking on the black, downward-pointing triangle to the right of each field. You can then choose to save the 

most recently entered information for that field, choose from a list of previously saved terms or choose to remove 

that entry from the pick list. This is a bit different from a similar option in the Photoshop File Info dialogue, which 

automatically remembers all your most recently used items (including the ones you misspelled!). With Photo 

Mechanic you can choose when and if these values are saved.  

When you first open a pick-list menu, there is an option to edit the values for that field. Click on that Edit (named 

field) option to bring up the Edit IPTC List dialogue, where you can enter any number of items and add them to 

the list. Selecting terms from these lists ensures all the spellings and letter cases will be the same. This can result 

in fewer problems when searching for images with those terms. Note there is a drop-down list at the top to allow 

direct access to all Stationery Pad field data lists. 

 

You can use the Edit IPTC List to preload or edit all values for a specific metadata field pop-up pick list. Once in any of these 

edit lists, you can access the rest of those available via the menu at the top of the dialogue. 

 

To smooth your workflow, set up as much of this as you can in advance. Then be sure to back up these sets of 

data on a regular basis, especially after entering a lot of new values. If you typically apply several of these 

different fields at one time to a folder of images, you’ll be glad to learn you can also save the entire IPTC 
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Stationery Pad as a template for later use. There are two options: Use the Load button to retrieve values saved as 

templates (covered below), or use the Snapshot button (the button with the lightning bolt icon in the lower left 

corner of the IPTC Stationery Pad dialogue) to save the current set of data for later use. 

When you click the button to Apply Stationery Pad to Selected, Photo Mechanic moves through the selection, 

applying metadata to each image file (or to each set of files if you capture Raw+JPEG) as determined by the 

settings in your preferences. A progress bar will appear but if you are only writing a small number of files you 

might miss it. 

 

In the Mac version of the IPTC Stationary Pad dialogue above, the cursor points at the Object Name field, where the 

'Variable' {filenamebase} is used to automatically input the filename of the current image into the photo metadata. 

 

Saving IPTC Stationery Pad Settings 

In the lower-left corner of the IPTC Stationery Pad dialogue, you have the option to Clear, Load or Save the 

values in the Stationery Pad. Pressing the Clear button removes all values and unchecks the box next to each 

value. If you need to selectively clear a set of terms, simply hold down the Option key (for Mac) or Shift key 

(Windows) to change the Clear button to an Options button. Click this to button to open a dialogue where you 

can set options for which data fields to clear and which to leave unchanged when you use the Clear button.  

The Load button allows you to import a previously saved set of values. Photo Mechanic can either load XMP 

metadata templates (such as those created by Adobe applications) or .IPT files (a format used by earlier versions 

of Photo Mechanic) from a location you choose. It will automatically check the box next to each value to include 

when the “Apply Stationery to Selected" button is pressed. The Save button allows you create a template for later 

use. You can save the template as either an .XMP or a .IPT file.  
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You can easily retrieve or save sets of metadata values with the buttons found in the lower-left corner of the IPTC Stationery 

Pad dialogue. The lightning bolt symbol signifies the Snapshot button. 

You can also access any previously saved value from each field’s pop-up list or save new values to these lists. 

Since it is easy to toggle these values on and off with the check box, you might find it easier to save a stationery 

pad or template that includes the fields you would typically include in most of your images. If it turns out that value 

is not appropriate, you can uncheck the box next to the field, choose the value from the pop-up, or type in a new 

value. Using pre-existing values ensures you consistently spell metadata terms each time you apply them. 

 

expert tip 

In versions 4.6 or later of Photo Mechanic, it’s possible to export the stored values in these pop-ups as a group, 

along with all your other preferences. At the lower-left corner of the Preferences dialogue, you will see both an 
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Import and an Export button. If you select the Export button, you can select specific pop-ups field lists (as well as 

other preferences and settings0 and save these to a proprietary .PMX file. Just click the Export button in the 

Export Preferences Settings dialogue, give it a name and indicate where to save the file. You can import this file 

into other installations of Photo Mechanic. Note that whenever possible, the values in the pop-up fields list will be 

merged with those existing in the version to which you are importing. Other settings, such as those in your 

IPTC/XMP preferences, will be replaces, so take care if you select all values in the Export Preferences Settings. 

 

 

When importing previously saved Photo Mechanic preferences, you have the option of merging the settings whenever possible 

by activating the check box. If there are conflicts, a prompt will ask whether you wish to replace the current settings with the 

new ones being imported. 

If you start filling out an IPTC Info dialogue and realize – too late – that you intended to use the IPTC Stationery 

Pad, don't worry. Just hold down the Option key (Mac) or the Shift key (Windows), and the Apply Stationery Pad 

button changes to a Copy to Stationery button. If you press this button when it appears, all the values you have 

entered in the IPTC Info dialogue automatically transfer to the IPTC Stationery Pad. This works for any image with 

previously entered information, as well, so you can easily leverage any existing image file as a template in the 

IPTC Stationery Pad. 
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Just hold down the Shift key (or Option key on a Mac) and the Apply Stationery Pad button changes so you can copy the 

information shown in the IPTC Info dialogue to the IPTC stationery Pad. 

Since there are two options for entering metadata, it’s likely that at some point you will select a group of images, 

begin filling in fields and realize you opened the IPTC Info dialogue. If that happens, don’t worry. You can make 

this dialogue work like the IPTC Stationery Pad. Just hold down the Option+Control keys (Mac) or Shift+Ctrl keys 

(Windows) and the Apply Stationery button changes to an Apply to Selected button. This works just as the 

IPTC Stationery Pad, except your values are not stored for future use.  

APPENDING METADATA 

Typically, you either add or replace the metadata in a given field. But there may be times when you simply want to 

add additional data, not remove what is already present. Photo Mechanic automates a several fields with an 

append option. You can append data to the Keywords, Caption and Caption Writers fields by checking the Plus 

(+) sign next to the field. This will then append the data rather than replace what is present. Note: To avoid having 

the first character of your appended text butt up against the end of the existing text, it is a good idea to add a 

blank space, or comma and space, at the beginning of what you enter. 

 

 

Auto-enter Data With Variables 

Another way you can speed up data entry and avoid drudgery is with the use of Variables. Open this option using 

the Variables... button at the bottom center of the IPTC stationery Pad dialogue. 

Simply choose a field, click on the Variables... button and choose a value from the list by double clicking. The 

code to access that variable will appear within braces {}. When you apply the IPTC Stationery Pad, the actual 

value will be substituted in place if that Variable.  

 

With this feature, you can automatically write the filename of your original image into the Object Name field by 

choosing {filenamebase}. This saves you the drudgery of manually typing the filename for each image. More 
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importantly, it ensures there is another way for your clients to tell you which file they need if they downloaded a 

preview image from your website and changed the file name on their copy. 

There are other inventive ways to use this option. For instance, if you wanted to add all of your geographic 

information to your keywords, you could simply put the following {city}, {state}, {country} into your Keywords 

field. If you want each to appear as a separate keyword, you need to place a comma and blank space between 

each value. 

expert tip 

Code replacement 

For those who photograph repetitive subject matter, there is the option to use something called Code 

Replacement any time you have common terms you tire of entering for each image. Code Replacement works in 

every text field of the IPTC Info and IPTC Stationery Pad dialogues. 

For example, when photographing a basketball game, you could preload a file that has all of the players’ numbers 

and names. In Photo Mechanic, you simply enter a delimiter (from version 4.4.3.2 forward, you choose the 

delimiter) and the player number. Photo Mechanic will drop in the player's name (spelled correctly) where it finds 

that code. So you could type in /#2/ and get in LeBron James. If photographing musicians or other performers, 

you could create codes for each person and use their initials or first names as part of the code, so you could type 

in /#db/ and get David Byrne.  

This same feature can insert the contents of a text file containing filenames and keywords, so the keywords are 

embedded into the Keyword field of your images without repeatedly cutting and pasting. 

Autocomplete 

If you find yourself typing the same terms repeatedly, you might want to turn on the Autocomplete feature. This 

function was introduced in Photo Mechanic 4.6.x and is another method that can speed you caption writing and 

metadata annotating. This real-time word completion feature can use lists of terms in a text file you create, words 

within the IPTC field lists you have created or even items from the {variables} menu. This feature is off by default, 

but you can enable it with by accessing the Set Autocomplete... menu item within the Settings submenu under 

the main Edit menu.  

 

Enable the Autocomplete feature to speed up your caption and metadata writing. 

To use this feature, begin tying normally. When Autocomplete senses you’re entering the first few letters of one 

of the stored words or phrases, it locates the first alphabetical match and completes the word, highlighting the 
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remaining letters to the right of your cursor. If the word you see doesn't match, keep typing until Autocomplete 

finishes the word you want, or until you type the entire word. This feature works best with single words, but will 

work with phrases, as well – although not as effectively. This is because Autocomplete only considers the last 

word typed and will start looking up words that start with the first letter of the next word in the phrase. Camera Bits 

says this will improve in future releases. 

When creating Autocomplete text files, make sure you only enter one word (or phrase) per line. If any of the 

words contain letters with diacriticals (tildes, umlauts, or other accented characters) or are written in a non-Roman 

script such as Japanese (Hiragana, Katakana, or Kanji) you will need to save the text file using UTF-8 encoding. 

 

VERIFYING METADATA ENTRY 

Photo Mechanic makes it easy to enter metadata, but sometimes it can be hard to know whether you have 

already entered the metadata for a particular image – especially if you applied some metadata on Ingest. If you 

have just brought in a set of images from your camera, it is safe to assume they contain no descriptive metadata. 

However, if this is a folder of images you worked on previously and are not sure whether you finished, it may not 

be obvious which images were annotated – at least not without opening the IPTC Info panel for each image. 

Fortunately, there is more than one way to view the descriptive metadata for each image file in Photo Mechanic. 

The most obvious method is the one mentioned earlier, when in the contact sheet view (the one with lots of 

thumbnails showing). Just hover your cursor over the file you want to check and select the "i" pop-up box in the 

lower-left corner of the file thumbnail. This will open the IPTC Info dialogue for that image. Alternatively, you can 

select an image and press "i" on your keyboard. If you have already double-clicked on the image so it is open in 

the viewer, you can still use the "i" keyboard shortcut, or click on the fifth icon from the left in the Preview 

window's tool bar, which looks like the letter “I” in a circle. Once that dialog opens, you can quickly move to the 

data for the next image by clicking on the Next arrow navigation button under the thumbnail image in the dialogue. 

 

You can rapidly move through the metadata for a folder of images using the next arrow button (shown highlighted in the 

Windows IPTC Info dialogue above). 
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A much quicker way, especially if you want to immediately see whether your images already contain metadata – 

and not have to press any keys or choose from menu items – is to use the Info Tooltips option located under 

the View menu. Make sure the check is showing next to the Show Info Tooltips item in that menu, and when 

you move your cursor over an image, a black box will appear beside it, showing you a preset list of values.  

 

You can modify and activate the Info Tooltips option to reveal a specific set of metadata fields whenever you hover your 

mouse cursor over an image in the contact sheet view. 

The default setting for the Info Tooltips primarily shows Exif data. You can see this same info if you Conrtol-click 

(Mac) or right-click and choose “Image Info” – but activating the Info Tooltips does the same with less effort. 

 

Turn on the option to see the Info Tooltips when you hover over an image by locating the Show Info Tooltips in the View 

menu. 
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You can easily configure Photo Mechanic to show a different set of metadata fields. Under the Edit menu locate 

the Settings submenu and select the Set Info Text... option. This will open a new dialogue where you can tell 

Photo Mechanic which fields to display. The presets, which mostly show Exif info, appear by default; however you 

can remove these entirely or leave them if you wish. 

 

To change the fields seen in the Info Tooltips view, start by locating the Set Info Text option under the Edit menu. 

 

You can configure the Info Tooltips option to show any combination of fields. Locate the name of the field from the Variables 

dialogue and include any other explanatory text you need to help you make sense of what is displayed. In the example above, 

the Keywords field has been placed at the bottom, since the long list of fields and data might exceed the display area when 

your cursor hovers over the image. 
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There are many options besides showing just the Exif or other standard IPTC fields. Within the Set Info Tooltips 

dialogue, click on the Variables… button to bring up the entire set. It includes GPS, ICC and many other data 

types. Near the end of this very long list, you will find a set of IPTC variables. If you choose Caption, Capt, 

{caption} will appear in the field where the cursor was last located. If you type Caption: it will read Caption: 

{caption} when you mouse over with the Show Info Tooltips option turned on.  

To add the Keywords data, put Keywords: {keywords} on a line below the caption, and you can quickly see 

whether an image includes these annotations without lifting a finger or pressing a key.  

If you only want those two fields, the contents of the Set Info Tooltips dialogue would look like the following: 

Caption: {caption} 

Keywords: {keywords} 

If you wanted to know whether an image file includes GPS information, along with the camera’s aperture, shutter 

and ISO settings, you might construct a list like: 

Caption: {caption} 

Date: {date}, Time: {time} 

Model: {modl}, Serial #: {snum} 

Firmware: {firm}, Frame #: {fnum} 

Actuations: {actuations} 

Latitude: {glat} 

Longitude: {glon} 

Altitude: {galt} 

Lens (mm): {lens} 

ISO: {iso} 

Aperture: {f} 

Shutter: {shut} 

Program: {prgm} 

White Bal.: {baln} 

ICC Profile: {icc} 

Keywords: {Keywords} 

If you want to use the set above, simply cut and paste these values from above directly into your Set Info Text 

dialogue.  

You can also use some of these same variables to modify the Thumbnail labels that appear below each 

thumbnail. Those settings are inside the Preferences dialogue. Go to the Contact Sheet tab, and under the tab’s 

Thumbnails section, use the pull-down menu, beside the top Label field to change Name Only to Name + 1 label 

(or two or three if you want more). The field marked Label 1: directly below that will no longer be grayed out, and 

you can input {caption}, or {keywords}. From that point forward, you will see this information below the filename, 

under the thumbnail – as soon as you add a caption or keyword to an image. 

 

LOCATING PHOTOS 

Find 

There is a Find feature under the Edit menu for searching all images within the current contact sheet or just the 

current selection. You can limit its search to specific fields by using a set of check boxes, and even make 

searches case sensitive. Type the search term, and Photo Mechanic will highlight image files in current folder that 
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include the searched value. The result is a set of highlighted thumbnails ready for your actions (such as opening 

the IPTC info or applying the IPTC stationery pad). 

With some find operations, you may discover other images seem to have vanished. If so, you have probably 

triggered the View Selected option (F2; also under the View menu). To return to the full contact sheet, use the 

View All option (F1). If you’re not good at remembering shortcuts, just recall both options are under the View 

menu.  

Unlike some other browsers, the Find feature in Photo Mechanic only searches the folder currently visible in the 

contact sheet view. Windows users seeking images outside the current Photo Mechanic contact sheet will need 

other cataloging applications or utilities. 

Search 

Mac users have another option, since Photo Mechanic integrates with the OS X Spotlight feature to offer a 

Search feature, as well as the Quick Search option in the upper right corner of the contact sheet view. Either 

allows you to search for images on your local computer or network directly from Photo Mechanic. There are some 

limitations: Spotlight (through at least OS X 10.5x) only searches a portion of the legacy IPTC data (not XMP). 

Open the Search option (under the Edit menu) to see a list of fields indexed (and searchable) by Spotlight. 

 

The Mac version of Photo Mechanic integrates the Spotlight feature of the Apple operating system. This means you can use 

any of the following metadata fields to search for images on your computer. 

Find and Replace 

The Find and Replace options under the Edit menu, as well helping you correct mistakes easily and painlessly. 

For instance, if you accidentally misspelled a word or name, you could use this dialogue to replace it in a specific 

field, or in any metadata field where it appears. Like the regular Find, this feature can also limit the replacing to 

only those images currently selected rather than the entire folder. Do exercise care with this, as you can easily 
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replace more than you intend, especially when searching short strings of letters. For instance, replacing the word 

and with or would also change a word such as Andy to ory unless you checked the Case sensitive search box.  

 

You can Find and Replace specific words or phrases in any of the descriptive text fields, for an entire folder or for the current 

selection: you can even specify whether the search should be case sensitive or not. 

APPLYING KEYWORDS WITH PHOTO MECHANIC 

There are several ways to apply keywords with Photo Mechanic. The simplest method is to type terms directly 

into the Keyword field, using a comma (or a semi-colon if you chose that option in Photo Mechanic's Preferences) 

to separate each term. The other options are the Keywords and Structured Keywords panels. 

In early version of Photo Mechanic, the only other method was the IPTC Keywords dialogue accessed by the Edit 

Keywords… option beside the Keywords field. You’ll find a simple list of terms that can be pulled from a master 

list and assigned to an image. You can also move existing keywords from an image to the master list. And this 

may be sufficient for those who only deal with a few keywords.    

While Keywords lets you pick terms from a flat list of keywords, the Structured Keywords Panel allows you to 

create a hierarchically arranged set of keyword branches that start with a broad topic term and fork out to contain 

any number of narrower terms. You can also import constructed sets of these keywords from specially prepared 

text files. The major advantage to this method is you can leverage the hierarchical nature of a keyword set. 

Selecting a narrow term, such as boy nets you people, human beings, humans, person, male biy, lad and young 

man, with a single find and a few clicks of your mouse.  

You can create controlled vocabularies from scratch by right-clicking in the columns and selecting Create Child or 

Create Siblings, etc. You can Import text files with the Load and Merge buttons, and save edited lists with the 
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Save button. Saving and backing up your lists is a good idea, especially if you are keywording with several 

different computers, ensuring all words are spelled and applied consistently.  

But note there are several ways to open the Structured Keywords Panel and apply keywords. 

If opened from the Image menu, the Structured Keywords panel will remain open while you keyword. This 

version of the panel has more options than you see when accessing Structured Keywords from within the IPTC 

Info of IPTC Stationery Pad dialogues. In the lower left corner of this floating version of the Structured Keywords 

Panel, are three pull-down menus. These provide several options for applying keywords terms and their 

hierarchical branches, so check the default behaviors to be sure they work as you expect. Unless you have a 

more specific need, you’ll probably find it best to set them as follows:  

Apply to: set to Keywords and check “Append” 

Double-click: Adds Path to Collection 

Synonyms: Apply Synonyms along the entire path 

 

The Structured Keywords dialogue (Windows version shown above) makes it easy to choose a single narrow keyword and end 

up with a set of hierarchically branching keywords with only seconds of effort. 

If you have the IPTC Stationery Pad or the IPTC Info dialogue open, you can choose the Structured Keywords 

dialogue, from the pop-up lists under the little arrow to the right of the Keywords field. Keywords selected from this 

instance of the Structured Keywords dialogue will first appear in the Keywords field in either of those dialogues 

and are only applied when you click Apply, followed by OK or Apply Stationery to Selected.  
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The main difference when using either of these options rather than the floating dialogue is the Keyword Collection 

is applied to the Keywords field of the IPTC Info or IPTC Stationery Pad dialogues. This eliminates the need for 

the three Apply button options in the lower right of the floating version of the Structured Keywords panel. All 

other functions are identical. 

The Structured Keyword Panel allows you to construct a whole collection of keywords first, before using the 

Apply Collection to Selected button to write the same terms to a set of images. This is more efficient, limiting 

the number of times you ask Photo Mechanic to write to the original file and saving time in your overall workflow.  

Within the keyword hierarchy, you can perform a Find for a particular term. Then by double-clicking the term in the 

list you can add the rest of the terms along that particular hierarchical branch and all synonyms along the pass will 

land in the Collection field toward the bottom of the dialogue. Once all the terms for that image, or selection of 

images, are assembled, you can click Apply Collection to Selection in the lower right corner (if using the 

floating version), or Apply (if in the IPTC dialogue’s version).  

A progress bar should appear to confirm the keywords are being added to the images. 

You can configure how the Find button works in the Structured Keywords windows by holding down the 

Option key (Mac) or the Shift key (Windows) and then clicking on the Find button.  

SUMMARY 

Photo Mechanic is a flexible and efficient image browser that has pushed the boundaries of metadata annotation 

for more than a decade. Users can quickly import, caption and rate/rank images. 

The program's powerful Ingest command can move your images from memory cards, flatten directory structures, 

apply IPTC metadata, renames files and even create backups on separate disks – all in a single step. Photo 

Mechanic helps you rapidly edit large number of photos and identify the best. In addition, its many output options 

allow photographers to easily create web galleries and slideshows, print contact sheets, transfer photos to an FTP 

server, upload them to an online archive, share photos via email, store favorites, and much more. 

 

 

 

 

 

 

  

 

 

  

 

 


